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THK VLA Indexer
Introduction

The THK VLA Indexer allows a user to “program” motion on a 
VLA slide without ever learning or knowing a programming 
language. 

The user simply answers a series of questions about the slide 
being used, the load connected to it, and what will cause it to 
energize and home. Then the user creates one or more sequences 
that the slide is required to perform using pre-defined events like 
“Move Start”. Once all of the parameters are entered into the 
events chosen by the user, a program can be generated and sent to 
the controller by compiling and downloading.

The program created and downloaded will begin running 
immediately. It will set all necessary parameters, wait for the 
condition chosen to energize the servomotor, and then enter 
either the manual or automatic mode. The manual or automatic 
mode is dictated by the state of input 8. If input 8 is high or off 
the program enters Manual mode, if it is low or on, Auto mode is 
run; but only after the servo is enabled the first time.

Manual mode allows the user to enable and disable the servo (if 
the choice to energize the servo was by input or variable), and 
once the servo is enabled, to jog forward or reverse.

Auto mode will home the servo once after a power-up when the 
condition to home is true, and then run sequences when their 
individual start conditions are true. If there is more than one 
sequence defined and the condition to start each sequence is true, 
then the sequences will be run in order one after the other, and 
will continue to run until the start condition is false. Remember, 
in order to enter the Auto mode, the servo must be energized.
1



Opening Screen

When the application is started, the user is presented with the 
opening screen, which allows the user to create a new project or 
open an existing project. 
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To create a new project

Select the template name “THK VLA Indexer” and click on the 
New Project button. 

Enter a project name, select “OK”, and the THK Wizard will 
appear.

To open an existing project

An existing project can be opened by selecting it from the list and 
clicking on “Open Project”, or by clicking on “Browse…” to 
locate the ***.yap file. A project can also be opened from the 
controller (if it was previously saved using the save project to 
controller option) by selecting “Retrieve Project From 
Controller” while connected online. 
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THK Wizard

The THK Wizard will guide the user through entering the THK 
part number of the VLA slide and selecting the load connected.

 

Locate the part number of the VLA slide. The part number is 
located on the left side of the actuator if the motor is positioned 
on the left.

Select the type of VLA slide by choosing either ST or CT. The 
picture changes as the selection is changed. Navigate through the 
screens using the Next button to advance. 
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Next enter the Slide Height.
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A ball screw lead must be selected if using an ST type slide. For 
the CT type, accept the 12mm default.
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Enter the Stroke Length.
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Specify the Load Direction and Weight.
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Select the Units.
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Select the side on which the actuator will home and click on 
“Finish”.
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Main Screen

The main screen features a Project Tree that is used to display 
items in the main window and a Progress Window that highlights 
the step currently being performed. Clicking on Project Tree will 
access the main folders that make up the program (modules, 
sequences, and variables).

Modules

Clicking on “Modules” will display the setup questions for the 
application. There are two ways to view the questions, one at a 
time (Wizard View), or all at once (Table View).  Wizard View 
displays questions one at a time with question specific help at the 
bottom of the main window. This allows the user to navigate back 
and forth using the Previous and Next buttons. Wizard View is 
the default view and is shown in the main window above.

Project Tree

Progress 
Window

Main Window 
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Table View displays all of the questions at once, with all but the 
last unanswered question grayed out. This focuses the user’s 
attention on the last unanswered question while allowing viewing 
of the entire set of questions that have been answered.

Clicking on the name of an individual module will filter the 
questions in Table View, displaying only the questions in that 
module. 
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Sequences

To create a sequence, right-click the word “Sequence” in the 
Project Tree and select “Add Sequence”.

Sequences are given meaning by adding events. To add an event, 
select one from the drop down list at the top of the screen and 
click the Add Event (+) button.

All sequences must begin with a Start By event (Input, 
Expression, or Variable) and there must be only one Start By 
event so place one of these events in the first position of the 
sequence window. 

Sequence view with no 
sequences defined

List of Events

Delete Event Move Event, Up
or Down Add Event
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Sequence Events

Start By Events: Expression, Input, and Variable
• Start by Expression must be valid comparison expressions in 

the form of x=2, y>7, or similar items that evaluate to Boolean 
true or false. This is an advanced event allowing anything to be 
specified, and is NOT checked for errors. If unsure, avoid using 
this event.

• Start by Input asks the user to specify an input number and 
state or transition of the input. Valid input numbers are from 
1~7 (and 2000~2255 if using Ethernet I/O). Specifying a state 
will cause the sequence to run when the input is On or Off, 
while specifying a transition will wait until the edge or change 
of the input occurs.

• Start by Variable requires the user to enter a variable name 
and value. Valid variable names are 1 to 8 characters in length, 
case sensitive, and accept alphanumeric characters and the 
underscore. The value entered is the value that will cause the 
sequence to run.

The user adds the remaining events as needed to form the custom 
sequence required for the application. 

Change Events: Accel and Speed

These events are useful for changing values while moving.
• Change Accel allows the user to specify a new acceleration. 
• Change Speed allows the user to specify a new speed.

Loop Events: Expression and Fixed Number

A Loop event will cause the program to loop back to a previous 
labeled event. 

An event is labeled by entering a name for the event in the 
response column on the row of the event name. The Loop event 
will only allow program flow to return upwards. Program flow 
cannot be returned to the start event, or within a Move Start, 
Move End pair.
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• Loop Expression will continue to loop while the expression is 
true. Expressions are valid comparisons in the form of x=2, 
y>7, or similar items that evaluate to Boolean true or false. This 
is an advanced event allowing anything to be specified, and is 
NOT checked for errors. If unsure, avoid using this event.

• Loop Fixed Number will loop for the number of times 
specified.

Move Events: Start and End
• Move Start has the user specify all of the move parameters.

! Acceleration is entered in user units.
! Deceleration is entered in user units.
! S-Curve is the amount of motion smoothing applied to the 

move. A value of 1 indicates no S-Curve and .004 
indicates the maximum S-Curve. Applying S-Curve 
smooths the acceleration and lengthens the move time.

! Speed is entered in user units.
! Move Type can either be absolute or incremental. 

Absolute moves go to that absolute position (based on 
where the home position is), while incremental moves 
advance a certain distance from where they are currently.

! Position is entered in user units.

• Move End requires selection of either profiler or encoder. 
! Profiler will wait until the controller finishes calculating 

the move and sends the commands to the motor.
! Encoder will wait for the actual position of the motor to 

reach the calculated position.

Set Events: Output and Variable
• Set Output specifies an output number and a state (either on or 

off).
• Set Variable specifies a variable name and value.
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Wait For Events: Absolute Position, Distance, Input, Time, 
and Variable

• Wait for Absolute Position waits for the encoder to reach the 
position specified.

• Wait for Distance waits for the encoder to see a movement of 
the distance specified from the start of the move. 

• Wait for Input waits for the input to be at the state specified, 
or for the transition to occur.

• Wait for Time waits for an amount of time specified in 
milliseconds (where 1000 = 1 second)

• Wait for Variable waits for the variable specified to be set to 
that value.

Skip Event

Allows the program to conditionally skip one or more events. 

Sequence Rules
1. All sequences must begin with a Start By event, and there 

must be only one Start By event. So place one of these events 
in the first position of the Sequence window.

2. The program cannot loop back to a Start By event.
3. Every Move Start event must have one and only one Move 

End event.
4. Moves cannot be nested. If a Move Start event is placed in a 

sequence, then a Move End event must be placed in that 
sequence before another Move Start event.

5. The events Wait for Absolute Position and Wait for 
Distance must be placed within a Move Start, Move End 
pair.

6. If a Loop event is used, there must be a previous event with a 
label to loop back to.

7. If a Skip event is used, there must be a later event with a label 
to skip to.
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Variables

When variables are entered into the program, they automatically 
appear in the variable table. Variables in the program must be 
initialized. Specify a value for all variables used in the program 
or the compiler will prompt for values.

Menu Items 

The File menu contains the standard items that allow the user to 
create a new project (New), open an existing project (Open), save 
the current project (Save), and create a copy of the current project 
with a new name (Save As).

The Project menu allows the user to create a downloadable 
program file (Compile), to download the executable program to 
the controller (Send to Controller/Download), and to save the 
current project (Send Project File to Controller) on the controller.

All of the questions in the modules must be answered and at least 
one move sequence with a minimum of one event existing before 
the user is allowed to compile. 

The Tools menu allows the user to rerun the VLA slide selection 
Wizard if the user needs to change the model number. 

Program Flow

The program will begin running immediately after it is 
downloaded or whenever the power is cycled. It will set all 
necessary parameters, wait for the condition chosen to energize 
the servomotor, and then enter either the manual or automatic 
mode. If input 8 is High/Off, the program enters Manual mode. If 
it is Low/On, Auto mode is engaged; but only after the servo is 
enabled the first time.

Manual mode allows the user to enable and disable the servo (if 
the choice to energize the servo was by input or variable), and 
once the servo is enabled, to jog forward or reverse. Jogging 
forward or reverse is achieved by pressing the reverse or forward 
limit switch respectively. Jogging will continue for as long as the 
switch is held on.
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Auto mode requires that the servo be homed once after a power-
up. If the servo has not been homed, no sequences will run. When 
the condition to home is true, the servo will find the home 
position and then run sequences when their individual start 
conditions are true. If there is more than one sequence defined 
and the condition to start each sequence is true, then the 
sequences will be run in order one after the other, and will 
continue to run until the start condition is false. Remember, if 
Input 8 is High/Off, the program enters the Manual mode. If it is 
Low/On, the Auto mode is engaged, but only after the servo is 
enabled the first time.
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Power On

Set servo gains
Set parameters

Set internal
variables

Is Manual input
on

Manual Mode

Auto Mode
Is Servo-On

condition True

Turn Servo On

Turn Servo Off

Is Jog + input
on

Yes

Yes

Jog forward at  +
Jog speed

Yes

Is Jog - input
on

Jog reverse at  -
Jog speed

Yes

No

No

Is servo on
condition true

Turn Servo On

Yes

No

No

Home condition
= True & NOT

HOMED
Start Home

Home timeout

End

Set Error

Home Complete
Sequence 1

start  = True &
HOMED

Sequence n
start  = True &

HOMED

Run Sequence 1

Run Sequence n

Yes

Yes

Yes

Yes

Yes

No

No

No

No

No

No

Program Flow
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Sequence Terms
• Encoder: The physical device used to track position mounted 

on the motor.
• Expression: Must be valid comparison expressions in the form 

of x=2, y>7, or similar items that evaluate to Boolean true or 
false. This field is NOT checked for errors. If unsure, avoid 
using events with this parameter.

• Input: Valid input numbers are from1~7 (and 2000~2255 if 
using Ethernet I/O). Specifying a state will cause the event to 
run when the input is on or off while specifying a transition will 
wait until the edge or change of the input occurs (i.e. the input 
must go from 1 to 0 or from 0 to 1 before the event will run).

• Label: Labels are applied to events by entering characters in the 
response column next to the event name.

• Output: Valid output numbers are from1~4 (and 2000~2255 if 
using Ethernet I/O).

• Variable: Valid variable names are 1 to 8 characters in length,  
case sensitive, and accept alphanumeric characters and the 
underscore. Variable values are in the range  –
2147483648.9999 ~ 2147483647.9999 and have a fractional 
resolution of 1/65536.
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Hardware

Start-up
Mounting the LEGEND-MC to the LEGEND Amplifier

1. Insert the lower two mounting notches of the LEGEND-MC 
into the mounting holes at the bottom of the right side of the 
LEGEND.

2. Push the LEGEND-MC in the direction indicated by the 
arrow in the figure below, and insert the upper mounting 
notches of the LEGEND-MC into the upper mounting holes 
on the right side of the LEGEND.

Mounting Orientation
Mount the LEGEND-MC and LEGEND vertically for proper 
cooling, as shown below. Allow a minimum spacing of 10mm 
around the left and right sides and 30mm around the top and bottom 
of the LEGEND-MC/LEGEND unit.
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Front Panel Description
No. Name Description

(1) Power 
ON

A lit green LED indicates that the 
+5 VDC power supplied to the 
LEGEND-MC controller from the 
LEGEND amplifier is working.

(2) Alarm/
Error

A red LED that will flash on initially at 
power-up and stay lit for approximately 
1-8 seconds. After power-up, the LED 
will illuminate for the following 
reasons:
Position error occurs when the 
measured value is greater than the 
position error limit setpoint.   Manual 
reset of the controller, noise and/or a 
failure in the processor can also 
trigger this alarm for a short time.  If 
the error does not clear, please 
contact your local Yaskawa 
representative for assistance.

(3) CN6 9 pin male D-Sub serial port connector

(4) CN5 3M 50 pin high density I/O connector

(5) RST Reset switch. Causes the controller to 
reboot, and load the application 
program and parameters from flash. 

(6) Ethernet
status

A green LED that is lit when there is an 
Ethernet connection to the controller. 
This LED tests only for the physical 
connection, not for an active or 
enabled link.

(7) Ethernet
status

The yellow LED indicates traffic across 
the Ethernet connection. This LED will 
show both transmit and receive activity 
across the connection. If there is no 
Ethernet connection or IP address 
assigned, the LED will flash at regular 
intervals to show that the BOOTP 
packets are being broadcast.

(8) CN4 10 BaseT Ethernet RJ485 Connector

(9) FG Frame ground spade terminal. 
Connect to ground terminal on 
LEGEND Amplifier

(1)(2)

(3)

(4)

(5)

(7) (6)

(8)

(9)
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Power/Connections Wiring - Single Phase

Servo ON

2MC

Control 
Power 
OFF

Control
Power 
ON

1MC
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Noise Filter
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1MC 2MC

SUP
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2
N
C

G
F

LEGEND01
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L2
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2

L1C
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B3
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W

CHARGE POWER

C
N
1

2MC

1MC

Servo 
Power 
OFF

Emergency 
Stop

1MC

SUP

R T

Note: The LEGEND-MC receives its power from the LEGEND amplifier through the side 
interface connector, however, the digital I/O receives its power from pins 46, 47, 
48, and 49 on the I/O connector.
For maximum noise immunity, connect the FG to a ground terminal on the sub 
panel or to the ground terminal on the LEGEND.
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Power/Connections Wiring - Three Phase
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Note: The LEGEND-MC receives its power from the LEGEND amplifier through the side 
interface connector, however, the digital I/O receives its power from pins 46, 47, 
48, and 49 on the I/O connector.
For maximum noise immunity, connect the FG to a ground terminal on the sub 
panel or to the ground terminal on the LEGEND.
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I/O Connections (50-pin CN5)

1
Analog 1

+5 Filtered Output power (60 mA available)
-12 Filtered Output power (10 mA available)
+12 Filtered Output power (10 mA available)

Output compare (requires internal jumper)
External encoder A-
External encoder A+
External encoder B-
External encoder B+
Abort Input
Reverse limit switch
Home Input
Forward limit switch
Reset Input

                        E STOP2

                         24V GND Input

 
                        E  STOP1

24V Power Input 

24V GND Input 

24V Power Input 

CN5

Analog 2

Digital Input 2
Digital Input 1
Digital Input 7
Digital Input 8
Digital Output 4
Digital Output 3
Digital Output 2
Digital Output 1

Analog Output

LEGEND-MC Signal Ground

Digital Input 6
Digital Input 5
Digital Input 4
Digital Input 3

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
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Digital I/O

Digital Input

Note: Inputs float high unless the input is held low.

Item Specifications

Number of Input Points 8

Input Format Sinking

Isolation Optical

Voltage 24 VDC ± 20%

Current Rating (ON) 5.3 mA to activate

Input Impedance 2.2k Ω

Operation Voltage Logic 0 <5V
Logic 1 >15V

OFF Current 0.9 mA or less

Response Time OFF to ON: <0.5 ms
ON to OFF: <1.5 ms

Latch Response Time Less than 25 µsec

Minimum Latch Width 9 µsec

19 Digital Input 7

20 Digital Input 8

47

Legend-MC I/O 
Connector CN5

49

18

17

45

44

43

Internal Circuitry

2.2k

Digital Input 1
 (Main Latch)

Digital Input 2
(External Latch)
Digital Input 3

Digital Input 4

Digital Input 5

24VDC

42 Digital Input 6

Field Wiring

LEGEND-MC I/O
26



Digital Output 

Note: The ULN 2803 output chip is capable of 600mA at a single output,  or 800mA for 
the four outputs simultaneously.

Item Specifications

Number of Output Points 4

Output Format Sinking

Output Classification Transistor Output

Isolation Optical

Load Voltage 24 VDC ± 20%

Load Current 200 mA/Output (600 mA if activated individually)

Response Time OFF to ON <0.25 ms
ON to OFF <0.5 ms

External Common Power 24 VDC ± 20% 15 mA

Common User Fuse Rating 1A

Individual User Fuse Rating 200 mA recommended

23

22

21

46

48

L

L

49

Legend-MC I/O 
Connector CN5

47

24

Fuse

Digital Output 1

Digital Output 2

Digital Output 3

Digital Output 4

PS2505-4

ULN2803

10k

4
.
7
k

Internal Circuitry
24VDC

L

L

Field Wiring

LEGEND-MC I/O
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Emergency Stop Chain

25 E STOP2

Legend-MC I/O 
Connector CN5

50

VCC

-EROUT

1k

Q1

2N7002

U17

E STOP1

Internal Circuitry Field Wiring

Note: Note: The LEGEND-MC closes the relay contact under normal operating 
conditions. 
Ratings: 1.0A @ 24 VDC
0.5A @ 125 VAC
Maximum switching power: 62.5VA, 30W

LEGEND-MC I/O
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Serial Communication

Item Specifications

Baud Rate 9600 or 19200 set by jumper JP1, default is 19200

Data Bits 8

Parity None

Stop Bits 1

6

8

2

3

4

5

C1+
C1-
C2+

Legend-MC Serial 
Port Connector CN6

1

Internal Circuitry

CTS Output

7

9

CTS Output

CTS Output

Transmit Output

Receive Input

RTS Input

RTS Input

N/C

Signal Ground

MAX232A

U7

V+

V-

T1OUT

T2OUT

A1IN

A2IN

C2-
T1IN

T2IN

A1OUT

A2OUT

.1 UF

.1 UF

.1 UF

.1 UF

VCC

Field Wiring

Note: NOTE: Hardware handshaking must be used with the LEGEND-MC. If it is impos-
sible to implement hardware handshaking, use a jumper between pins 1 and 4 in 
the connector.

Note: NOTE: Do not connect pin 5 to a 24V ground.

LEGEND-MC Serial
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